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ABOUT THIS COURSE
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This class is designed to give a basic introduction into Microsoft Word 2007. Specifically, we will progress from learning how to open Microsoft Word to actually creating a document. It is impossible in two hours to become totally proficient using Microsoft Word, but it is our hope that this class will provide a springboard to launch you into this exciting world!  

Course Objectives  

By the end of this course, you will:
· Have a basic understanding of the Office Button and Ribbon in Microsoft Office 2007.

· Know how to start a new document in Microsoft Word, save it, and be able to find it later.

· Learn various formatting options in Microsoft Word. 
· Use various methods to format text in Microsoft Word.

· Know how to make a bulleted list.

· Be able to add images to your document.

· Know how to print.

This booklet will serve as a guide as we progress through the class, but also can be a valuable tool when you are working on your own. Any class instruction is only as effective as the time and effort you are willing to invest in it. We encourage you to practice between classes. There are Workshops from 1:30 – 3:30 Sundays and Wednesdays which are staffed by volunteers. You are welcome to come to any of these and practice your skills.
We have also provided several lists of resource materials that can be used for more information or practice. 

Janice Collins

Technology Supervisor
I. Beginning in Microsoft Word 

Opening Microsoft Word: To open Microsoft Word, click on the Start Icon, slide the mouse up so the cursor is on All Programs >Microsoft Office>Microsoft Word. The program will open showing a new document page. 

Title bar: located at the very top of the screen. On the Title bar, Microsoft Word displays the name of the document you are currently using. At the top of your screen, you should see "Microsoft Word 2007- Document1" or a similar name.
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When you first open Word 2007, you will notice a new look to the menu bar. There are three features that are very different:  the Microsoft Office Button, the Quick Access Toolbar, and the Ribbon. These three features contain many of the functions that were in the menus and toolbars of previous versions of Word. The functions of these three features will be more fully explored below. 
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Microsoft Office Button: The Microsoft Office button contains many of the functions that were located in the File menu of older versions of Word. This button allows you to create a new document, open an existing document, save or save as, print, send (through email or fax), publish or close.
Quick Access Toolbar: Right next to the Office Button is the Quick Access Toolbar. The quick access toolbar is a customizable toolbar that contains commands that you will probably use frequently. You can place the quick access toolbar above or below the ribbon. To change the location of the quick access toolbar, click on the arrow at the end of the toolbar and click on Show Below the Ribbon. You can also change the icons within the toolbar by clicking on various commands within the dropdown.
The Ribbon is located underneath the Quick Access Toolbar in the top portion of the document. It has seven tabs: Home, Insert, Page Layout, References, Mailings, Review, and View that contain many features of Word. Each tab is divided into groups. The groups are logical collections of features designed to perform functions that you will utilize in developing or editing your Word document. Commonly used features are displayed on the Ribbon. To view additional features within each group, click on the arrow at the bottom right of each group. 
Status bar: This bar appears at the very bottom of the screen and provides such information as the current page, current section, total number of pages, inches from the top of the page, current line number, and current column number. All of these options can be accessed by right-clicking on the Status bar.
 

Defaults: The standard font for Word 2007 is Calibri, 11 pt. This is a change from prior versions of Word. It is possible to change the default font. To do this: 
1. On the Home tab, click the Font Dialog Box Launcher, and then click the Font tab. 


2. Select the options that you want to apply to the default font, such as font style and font size. Click Default, and then click Yes.  This will change the default font on all “normal” documents.
Typing and inserting Text:  To enter text, just start typing! The text will appear where the blinking cursor is located. Move the cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the left button. Text will automatically wrap to the next line; if you want to start a new paragraph, hit the Enter button. 

Undo and Redo:  You can quickly undo most commands you execute by using Undo. If you then change your mind, you can use Redo. This can be done quickly and easily in two ways.

Exercise 1 – Undo Using the Menu Toolbar
1. Type:  Oh no, I made a mistake. 

2. Click on Undo in the Quick Access Toolbar. [image: image1.png]



3. The typing should disappear.  

4. Click on Redo. [image: image2.png]



5. The typing should reappear. 

These may well become your favorite buttons on the toolbar! You can also Undo and Redo using Shortcuts. CTRL+Z is Undo. Redo Typing is CTRL+Y. 
Spell and Grammar Check:  One of the wonderful things about Microsoft Word is that it checks your spelling and grammar as you type. Spelling errors display with a red wavy line under the word. Grammar errors display with a green wavy line under the error.  There are several ways to check your spelling. Today we are going to use one way; you can find Spelling and Grammar Check by clicking on the Review tab>Proofing Group>Spelling and Grammar.
Exercise 2 - Spelling and Grammar Check
1. Type the following sentence exactly as shown. Include all the errors. 
On Satrday, I  went to themall to windo shop..  
2. Using the right button of your mouse, click on the first word that has the red wavy line under it. 

3. Several choices will appear. Click on the correct one. 

4. Do the same thing with each of the words with wavy lines under them.

Exercise 3 - More Practice

Todiy is the first dy of Marcj.
I wish that I undertood yur directions.

Whut day would yu lke to go to to the mall?

Cume to the skool and volunter with us.

Isnt the weathr butiful today.
II. Formatting Text
Creating a New Document:  To create a new document, click the Microsoft Office Button [image: image3.png]


 and click New. You will notice that when you click on the Microsoft Office Button and click New, you have many choices about the types of documents you can create. If you wish to start from a blank document, click Blank.  If you wish to start from a template, you can browse through your choices on the left, see the choices on center screen, and preview the selection on the right screen. If you have internet access, you will also find many templates on the Microsoft website.
Today we are going to work on a flyer for a company called World Travel, Inc. So that you do not have to type the whole thing, I have saved the text on your desktop.
Exercise 4
1. Click on Open from the Office Button. 
2. Open the document: World Travel Inc.doc.
Notice how long lines are wrapped to fit inside the page. This word wrap feature means that you don't have to press Enter every time the text reaches the edge of the page. Your paragraphs will continue to wrap as you make changes to your text or change the page margins or do anything that would change the fit of the text to the page. So remember - don't press Enter until you need a new paragraph!
Selecting Text: In order to change anything about text once you have typed it in, the text must be highlighted. Select the text by dragging the mouse over it while holding down the left mouse button or hold down the SHIFT key on the keyboard while using the arrow buttons to highlight the text. The following table contains other shortcuts for selecting a portion of the text:

	Selection
	Technique

	Whole word
	Double-click within the word.

	Line
	Click in the left margin next to the line you want to select.

	Whole paragraph
	Triple-click within the paragraph or double-click in the margin next to the paragraph.

	
	

	Several words or lines
	Drag the mouse over the words, or hold down SHIFT while using the arrow keys.

	Entire document
	Choose Editing | Select | Select All from the Ribbon, or press CTRL+A or triple-click in the left margin.


Exercise 5 - Selecting a Line

1. Move your pointer to the margin area beside the first line until it changes from the I beam shape [image: image4.png]


 to the selection shape [image: image5.png]


. This unmarked area just to the left of the text area is called the selection area. The only way you know you are there is that the pointer shape changes from the I beam shape to the arrow. Move too far to the left and you are out of the selection area. The pointer remains an arrow though. It's a bit confusing until you get used to it.
 

2. Select the first line by clicking in the selection area beside the line. This will highlight the entire line! Of course, you can also drag from one end to the other of the text you want to select.
Exercise 6 - Formatting Line One
1. With line 1 still selected, from the Font Group on the Home tab select Matura MT Script Capitals font, Font size: 36, color: green, and make it bold [image: image6.png]


  .
2. Click on the little arrow in the right-hand corner of the Font Group. The Font Dialog Box pops up. For those of you who have used previous versions of Word, this box will be very familiar. From this box, click on Shadow.
3. Click on OK to apply your changes.
4. Go to the Paragraph Group (next to the Font Group) and click on Center.
Exercise 7 - Formatting Line Five
1. Select line 5 which contains the words "Anniversary Specials". 

2. Right-click on the highlighted text and choose Font from the popup menu.

3. In the Font dialog box change: Font = Arial, Style = Bold Italic, Size = 24, Underline = Single, Color = Green.
4. Click ok.
5. Center the line using the Center button in the Paragraph group.
Exercise 8 - Selecting and Formatting Multiple Lines
1. Move the pointer to the left margin beside line 8, which starts the paragraph "In honor of...".
2. Click to select the line, but don't release the mouse button yet.
3. Drag down the left margin to the end of the list of trips and release the mouse button. You will highlight all the lines you dragged across.
4. While the text is still highlighted, choose Font = Arial, Size = 18, and click [image: image7.png]


 the Bold button.
Exercise 9 - Formatting Last Two Lines 
1. Select the last two lines of text. Choose Font = Arial, Size = 20, and click [image: image8.png]


 the Bold button using the icons in the Font Group. 
2. Center the lines using the Center button in the Paragraph Group.
Exercise 10 - Formatting Words using the Font Dialog box
1. Select the word Tahiti by double-clicking it.

2. Choose Font Color = Dark Red, Font = Arial, Size = 18 from the Font Group.
3. Repeat for the word New Zealand.
Saving and Closing a Document:  In order to find your file later, you must save it. If you are saving a file that has not been saved before, the Save As dialog box appears automatically when you click Save. Click options in the Save As dialog box to save a file to a file name, format, and location that you specify. After you save a document, when you click Save, the file will automatically save without a dialogue box coming up. If you want to save the file with a different name or to a different location, you must choose Save As and specify the new information when the dialogue box appears.

Exercise 11 - Saving a Document
To save your file and close Word, follow the instructions below: 

1. Click on the Office Button. 

2. Click on Save or Save As. 

3. Specify the correct folder in the Save In box (at the top of the window). Choose Desktop to save in. 

4. Name your file by typing your name in the File Name box. 

5. Click on Save.  The Save window will close. If this is a file that you have already saved and wish to save in another location or by another name, choose Save as.
Exercise 12 - Closing Microsoft Word

1. Click on the Office Button in Word.

2. Click on Close. This will close your document and the Microsoft Word program. You can also close the document by clicking on the X at the top right-hand corner or go to the Office Button and click Exit Word. If you click on Exit Word, a dialogue box will pop up asking you if you want to save your document.
To continue working on a file you previously saved, you must open the file. 
Exercise 13 – Opening a File
1. First open Microsoft Word. Click on the Office Button. 

2. Click on Open. 

3. Make sure the folder you saved your document in displays in the Look In field. 

4. Type the name of the file in the File Name field or scroll down to find the title in the   window. 

5. Click on Open. 

6. The file you created should appear. 

Let’s continue working on our flyer. We will add a bulleted list, create a border and add some shading.
III. Formatting the Document
In a bulleted list, each item in the list is preceded by a dot, square, or other shape or image, which is called a bullet.

Exercise 14
1. Select the lines which list the trips. 
2. Click the Bullet button [image: image9.png]


 on the toolbar to turn these lines into a bulleted list. 
3. If you would like to change the style of your bullets, select the lines again.
4. Click on the dropdown right next to Bullets. 
You can choose any of the styles you see or make your own! Let’s go ahead and customize our bullets so they are exactly what we want! 
1. Click on Define New Bullet.  
2. When the Dialog Box pops up, click on the Picture button to add a picture. Choose any picture you wish.
3. Click on OK until you are back in your document. 
Adding Shading or a Border to a Document: Shading is a colored or patterned background. Pictures and text are on top of the color or pattern.  Let’s add some shading to our flyer.
Exercise 15
1. Select the lines listing the trips by dragging down the margin. 
2. From the Paragraph Group, click the dropdown next to the little bucket. 
3. Choose 25% gray (the fourth choice).
4. While the lines about trips are still selected, click on the dropdown next to the Border icon.  Click on Borders and Shading. Click on the setting Box. 
5. Select the solid line Style.
6. Select line Width of 2¼ pt.
7. Select Apply to: Paragraph.
8. Click ok.
Border options: You can click on the picture in the right of the dialog box to select which edges you want to show a border. Under Options, you can change how far from the border the text is. The default is 1 pt. top and bottom and 4 pt. left and right.
Adding Images:  To help you find the right image quickly, Microsoft Clip Gallery and Clip Organizer group images in categories/collections. 

Exercise 16
1. Click on line 3, which is blank. This puts the cursor in that line. You will put an image on this line.

2. Click on the Insert tab and click on Clip Art within the Illustrations Group. 
3. The Task Pane opens at the right with the Clip Art search pane showing.
4. Type in a search term and Word will look for an appropriate picture. Try the word “luggage or travel”.

5. When you find a picture that you like, click on it and it will appear in your document. 

Often the picture is not the size you would like it to be. One of the great features of Word is the ability to change the size of images in your documents.

 Exercise 17 - Centering and Resizing an Image
1. Select the image in the document by clicking on it. Handles appear at the corners and in the middle of each side. 
2. Center the image while it is still selected. If you need to select the image again, just click on it once. To center it, click the Center button. [image: image10.png]



3. Move your pointer to the bottom right corner handle until it changes to the Diagonal Resize shape. [image: image11.png]


  Dragging with a corner handle changes the width and height at the same time without changing the proportions of the image.
4. Drag to the lower right to enlarge the image. When you let go, the image re-centers. Drag again until the image is about as wide as the subtitle "Anniversary Specials". You may need several tries to get the size right. To reduce the size, just drag a bottom corner handle up and to the left. 
Did the lines at the bottom of the page pop over onto a second page when you enlarged the picture? What happened?? If they did, either make the picture smaller or delete any extra lines in your document.

Printing:  Now that we have created a masterpiece, let’s print it!

Click on the Office Button and then Print. A window will appear like the one below. 

[image: image12.png]Print:

print what: | Document =

@ \\Stefanie-pc|HP Deskjet F300 Series (Copy 1)
1de

HP Deskjet F300 Series.
UsBo01

Curentpage . selecton
Pages:

Type page numbers andforpage
ranges separated by commas counting
o the startof the document o the
secton. For exanple, type 1,3, 512
orpis, pis2, pis3-pas3

Allpages inrange =





Look at the left side under Page Range. You can determine the number of pages to print here. If you only want one page, make sure that you either click “Current page” or click “Pages” and make sure “1” is in the space next to it. Also, notice on the right side under Copies that you can choose how many copies to print. 

Before you actually print your document, you might want to check the “Print Preview”. To do this, click on the Office Button and then Print Preview. This will show you how your document will look when printed. If you like the way it looks, you can click on the print icon [image: image13.png]


 or you can click on Close and go back to your document.

We hope that this class has been helpful. Remember, though, you must continue practicing in order to become really competent at any computer program. We  have Workshops on Sundays and Wednesdays from 1:30 – 3:30 p.m. that you may attend at any time. Volunteers are available to help with any questions that you might have. It is not necessary to signup or make a reservation, you can just show up! 
 Mouse Basics


The mouse pointer changes shape when it crosses different objects on the screen. 
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	Where you can click an item. 

	(
	Where you can drag to resize an object.
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	Where you can type text.
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	Where you can drag a window or dialog to move it.
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	Where you can click a hyperlink.


Mouse Actions

· Pointing

First, rest the heel of your hand on the desktop or table in front of the mouse. Put your hand over the mouse and hold it on one side with the thumb and on the other side with the ring and little finger. Now you can use your thumb and fingers to move the tip of the arrow. Sliding the mouse on the mouse pad moves the pointer on the screen. 

· Clicking

When clicking, it is very important to hold the mouse still. Normally, you will use the left button when clicking. The lighter you click, the better clicking works. Gently pressing the left mouse button is one way to give the computer a command to do something. When the mouse is over a picture or word that is a link to another page, the cursor will turn into a pointing hand. [image: image18.jpg]


Clicking the left mouse button will take you to the link. 

· Double-clicking

Double-clicking is clicking something twice in very quick succession. At first, many people have difficulty double-clicking because they do not click fast enough or are moving the mouse slightly between the clicks. The mouse must stay still between mouse clicks. When you open a program from the desktop, you must double-click.
· Right-clicking 

Gently pressing the right mouse button will show a list of available operations that can be performed on a particular object or file without going through menus. You can right-click on just about anything without worrying. You really can't do any damage with the right mouse button in Windows because it's designed to show only a menu (a list of options appropriate for the selected object). One of the options is usually Properties, which gives you access to lots of settings and information.

· Dragging

To drag your mouse, place the pointer over an object on your screen. Next press and hold down the left mouse button. Hold down the mouse button while you move the mouse. You can drag across text to select it. When the object that you moved is in the location of your choice, release the button.
· Scroll Bars

A good place to practice your dragging skill is on the scroll bars. If the window is too long to fit on the computer screen, there will be a scroll bar running up and down the right hand side of your screen. If the window is too wide, there will be a scroll bar running along the bottom of the screen. The scroll bar is a bar that has arrows on either end with a small box in-between those arrows. Click on the small box and, while holding down your left mouse button, drag the box towards the bottom of the screen to see additional areas of the screen. You can drag the box on the scroll bar up or down at any time. You can also click on the up and down arrows on the top or bottom of the scroll bar; this moves the scroll box up or down one line at a time. If you are scrolling up or down several screens, dragging the scroll box is a much faster way of moving than clicking the up and down arrows one line at a time. 

Remember:

· To move one line at a time, click on the [image: image19.jpg]


 arrow at the top of the scroll bar or the [image: image20.jpg]


 arrow at the bottom. 

· To move one screen at a time, click on the empty space within the scroll bar, above or below the elevator. 

· To move anywhere within the document, point to the elevator itself. Press and hold down the left mouse button. Now you can slide the elevator up or down by sliding the mouse on the mouse pad. Release the button when you are in the desired location.

Left Clicking and Right Clicking

	With the Left Mouse 

Button You Can:


	
	With the Right Mouse Button You Can:



	Single-click to select or highlight text or objects.


	
	Click once to view options.

Click on various features or within programs to view the available options like Cut, Copy, Paste, Preferences, Delete, Rename, etc.

Click on different icons, files, and programs to view their various options.

On the Internet

To open a new window, click on a hypertext link and select the option to open that link in a new window.

Click on a picture to save or copy the image or set it as the Windows desktop wallpaper. Can also access other options such as Copy, Save, Save Target As, Copy Shortcut, Add to Favorites, and View Properties.

	Double-click to open a file or start a program from the Desktop. Double-click to select a word.


	
	

	Click and drag to move a file to another location or copy it.


	
	

	Click and drag the cursor to mark a block of text.


	
	

	Click outside the selected or highlighted block of text to unselect it.


	
	

	Click to manipulate the scroll bar or access menus.
	
	

	On the Internet

Click to follow a hypertext link.

Click to navigate the various toolbars and menus on the browser or displayed on a web page.


	
	

	Remember!!!

The left button tells the computer           The right button gives you the 

 to do something.                                       options available at a particular place.                

                                                                   


 Resources @ the Library and Online
Microsoft Word 2007
Microsoft Word for beginners [text (large print)] (2008) by Web Wise Seniors, Inc.
Call number:   005.369 MIC/LGPR.
Microsoft Office Word 2007 Plain & Simple (2007) by Jerry Joyce and Marianne Moon.
Call number:   005.52 JOY.
Microsoft Office Word 2007 Inside Out (2007) by Katherine Murrey, Mary Millhollon, Beth Melton. Call number:  005.52 MUR.
Microsoft Office Word 2007 step by step (2007) by Joyce Cox and Joan Peppernau.
Call number:   005.52 COX.
Microsoft Office Word 2007 on demand (2007) by Steve Johnson.
Call number:    005.52 JOH.

Teach yourself visually Word 2007 (2007) by Elaine J. Marmel. Call number:   005.52 MAR.
Word 2007 : beyond the manual (2007) by Connie Morrison. Call number:   651.842 MOR.
First look 2007 Microsoft Office system (2006) by Katherine Murray. Call number:   005.5 MUR.

Office 2007 for dummies (2007) by Wallace Wang.  Call number:   005.5 WAN.

Teach yourself visually Microsoft Office 2007 (2007) by Sherry Willard. Call number:    005.5 KIN.
Websites – Free Tutorials

HP Learning Center - Microsoft Word 2007:  http://h30187.www3.hp.com/ 

Microsoft Website - Microsoft Word 2007:  http://office.microsoft.com/en-us/training/CR100654561033.aspx
Baycon Group -  Microsoft Word 2007:  http://www.baycongroup.com/wlesson0.htm
Florida Gulf Coast University – Microsoft Word 2007: http://www.fgcu.edu/support/office2007/Word/index.asp
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